
摘要

齿轮泵是应用最广泛的容积式液体输送泵，具有尺寸小、重量轻、制造容易、

工作可靠、价格低廉、对油液不敏感、自吸能力强、维护方便等优点。但它的输

出脉动明显、困油严重、排量小，限制了其应用场合。为了扩大其应用范围，本

文以齿轮啮合理论为基础提出了一种新型结构的齿轮泵。

新齿轮泵对普通齿轮泵的结构做了必要的改造，通过把两种不同模数的齿形

组合在一起，将运动、动力传递功能与工作容积变化功能基本分离。分离后，排

量增大为同等体积条件下普通直齿轮泵的2倍以上，而困油程度有明显减轻。

在新产品的设计过程中，详细研究了齿轮泵的流量特性。推导了计算瞬时流

量、流量脉动的计算公式，深入研究了齿轮泵的困油现象，推导出了计算齿轮泵

困油容积变化量的计算公式。并建立了齿轮泵的优化设计数学模型。应用ANSYS

软件参数化建模的功能，对齿轮齿形进行精确绘制，建立了齿轮泵的参数化啮合

仿真模型。此方法有利于齿轮设计的系列化和实现同类零件的标准化设计。采用

有限元法对齿轮泵泵体的结构和受力进行分析，并利用ANSYS软件的优化设计功

能，以单位体积排量最小为目标函数，实现了泵体结构的优化设计。使齿轮泵泵

体的体积减小、结构更加合理有效，解决了传统设计中凭借经验的问题。对新型

齿轮泵的间隙与泄漏作了详细研究，建立了径向间隙和轴向间隙二元流动泄漏模

型，并推导了最优间隙的计算公式。

为了便于与现有齿轮泵进行性能比较，本文取连盛液压机械有限公司生产的

CBG3200齿轮泵做了对比分析。优化设计后的结果表明，新型齿轮泵单位排量的

体积，比原泵下降了58％，困油容积变化量减少了约29％。因此，该大排量齿轮泵

具有良好的市场应用前景，论文对于同类结构件的强度计算和结构优化也有着重

要的借鉴作用。
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ABSTRACT

The gear pump is a volume type liquid delivery pump to apply in the most

widespread situation．It has many merits such as the size slightly，the weight light，

the manufacture easy，the work reliable，the price inexpensive，to the fat liquor

insensitive，self-absorption ability strong，maintenance convenience and SO on．But

its output pulsation is obvious，the trapping oil is serious，the displacement is small．

which have limited its application situation．In order to expand its application scope，

this thesis proposed one kind of new structure gear pump based On the gear meshing

theory．The changed trapping oil is reduced obvious．

The structure of normal gear pump has changed in the new gear pump，by

assembling two different module gear,SO as to separate function of change of the

working capacity from function of the movement and power transmission．After

separating，the output capacity is increased by more two times than that of normal

straight gear pump on the same condition of volume．

During the design of new product，the flow property of gear pump is studied in

detail．The formula of calculating instantaneous delivery and flow pulsation is

deduced，the question of trapping oil is studied deeply and the formula of calculating

change of volume of gear pump’S trap oil．The mathematical model of the gear

pump’s optimum design is built．The form of gear tooth is designed accurately by the

parameter modeling function of ANSYS software，and the parameter meshing

simulating model is built，which is useful for the design of serial gear and the

standardization design of similar part．The structure and the stress of the gear pump

are analysed by Finite Element Method，and based on the optimum design function

of ANSYS SOftware and completed the aim function with the minimum displacement

per volume，the optimum design of pump structure is realized，which makes the

volume of the gear pump body smaller and the structure more reasonable and

effective and solves the problem of traditional design with experience．Studied on

the clearance between the new model gear pumps and the leakage，the dual element

flowing leakage model of the clearance at the radial and axial direction is built and
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the calculating formula of optimum clearance is deduced．

In order to make it convenient for comparing performance with existing gear

pump，this paper uses CBG3200 gear pump produced by Liansheng hydraulic

Industrial Co．Ltd．to compare with．The result of optimum design indicates that the

displacement per unit volume of new gear pump decreases by 58％and the changed

volume of trap oil decreases by 29％．The large displacement gear pump studied in

the paper has good market，and it is very useful for reference when calculating the

strength and optimizing the structure in the similar part．

Keywords：Large displacement gear pump；Trapping oil；Parameter model；Finite

element analysis；Optimum design
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第一章绪论

第一章绪论

1．1齿轮泵的发展及其研究现状

1．1．1齿轮泵概述

在液压传动与控制技术中，齿轮泵占很大的比重，它广泛应用于机床、轻

工、冶金、建筑、船舶、飞机、汽车、石化等机械产品中。其主要特点是：结

构简单，体积小，重量轻，自吸性好，污染敏感性小，可靠性高，寿命长，制

造容易，维修方便，价格便宜等。同时，齿轮泵还存在一些不足，如排量小、流

量和压力脉动较大、噪声较大、高温效率低等。这些不足在某些经过改进的齿轮

泵上，虽已得到很大的改善，但尚需继续研究予以解决。

齿轮泵属容积型回转式泵，其工作原理是借助于一对齿轮副轮齿脱开啮合侧

和进入啮合侧在密封壳体内形成的工作容积的周期性变化来实现流体的输送。

图1-1齿轮泵的工作原理

Fig．1-l Work principle of gear pump

这里以外啮合渐开线直齿圆柱齿轮泵为例介绍一下齿轮泵的工作原理。如图1-1

所示，装在壳体内的一对齿轮的齿项圆柱、侧面及各个齿槽形成密封的工作腔。

齿轮泵的内腔被相互啮合的轮齿分为左右两个互不相通的空腔，分别与进液孔和
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排液孔相通。当齿轮按图示方向旋转时右侧吸入腔的轮齿逐渐分离，工作空间的

容积逐渐增大，形成部分真空，流体在大气压的作用下，经吸液孔m进入吸入

腔d，流体用疏的黑点表示。吸入到齿间的流体在密封的齿槽内随齿轮旋转被携

带到左侧的排出腔e，左侧的轮齿逐渐进入啮合，工作空问的容积逐渐减少，齿

问的流体被积压出去，从排液孔n经管道输出，排出腔e用密的黑点表示。当齿

轮不断旋转时，左右两腔不断完成吸入和排出过程，将压力流体压到液压系统中，

推动执行机构运动，带动负载做功。

其它类型的齿轮泵在结构形式上存在差异，其基本工作原理是相同的。

1．1．2齿轮泵的研究现状

由于齿轮泵在液压传动系统中应用广泛，因此吸引了大量学者对其进行研

究。目前，国内外学者关于齿轮泵的研究主要集中在以下方面：

l、 齿轮参数及泵体结构的优化设计f1-力；褚克勤【11分析了CBN．G3系列高压齿

轮泵，对泵体的材料和结构做了改进，提高了泵体的抗疲劳能力。殷金祥[2】、

李志华[31通过分析齿轮泵的性能指标，建立了齿轮泵齿轮参数优化的数学模

型，用优化方法寻得使齿轮泵的性能趋于最佳的齿轮参数。徐学忠【4】、李毅

华嘲、李晓宏[61分别对多齿差摆线齿轮泵、复合齿轮泵、多从动轮齿轮泵建

立了优化设计模型。Xiaojin Fu[71对直齿轮泵进行了模糊优化设计。这些研

究对齿轮泵的设计起到了一定的指导作用。

2、 困油现象及解决措施的研究[s-121。齿轮泵的困油现象对齿轮泵乃至整个液

压系统都会产生很大的危害，必须采取措施加以解决，为此一些学者进行

了相关研究。DukeK嗍给出了卸荷槽的设计方法。赵亮(9】分析了齿侧间隙很

小时直齿齿轮泵和斜齿齿轮泵困油容积的变化规律，并设计了消除齿轮泵

困油的导压槽。甘学辉[1卅对外啮合斜齿齿轮泵的困油特性进行了较详细的

研究。推导出了无侧隙斜齿齿轮泵消除困油时的临界螺旋角表达式。甘学

辉㈣给出了有侧隙斜齿齿轮泵的端面重合度与困油容积的关系，得到了其

困油容积、困油流量及瞬时流量随端面啮合点位置的变化规律，并得到了

不困油螺旋角范围。臧克江【121提出了一种降低齿轮泵困油压力的新方法

——卸荷降压槽法，并对其工作原理及作用进行了分析。这些研究对消除齿
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轮泵的困油，具有重要的理论价值和工程意义。

3、 齿轮泵的噪声控制技术[1’-19]。现在人们对噪声的控制越来越重视，而齿轮

泵的噪声大一直是令人困扰的问题。齿轮泵噪音大的原因是多方面的，但

主要是由困油现象、齿形设计精度以及齿轮泵的自身特点等因素造成的

m】【1”。其解决的途径也有多种‘1”．曲秀全Ⅱq等人提出了一种通过增加齿轮

泵工作齿轮的重合度，以及在轴端增加一对过渡齿轮两种方法来保证齿轮

传动的连续性和稳定性，从而消除由于冲击产生的噪声，并取得了好的效

果。文献【17】、【18]、【19]、【20]从动力学方面，研究了齿轮泵的动力学振动

性能，通过优化设计参数，从而使噪音降低。

4、 齿轮泵的变量方法研究[21-25]。齿轮泵的排量不可变也是限制其更广泛应用

的一个重要因素。如何才能使齿轮泵的排量可变?丁万荣等提出一种通过

改变齿轮泵齿轮的啮合长度来改变齿轮泵的输出排量，比较具有实用价值。

具体可通过手动或自动方式轴向移动从动齿轮的位置来改变两齿轮的轴向

啮合长度，从而实现齿轮泵输出流量的线性变化[2Hr“。当然也有一些其他

方法如改变这两个齿轮的齿数(齿轮的其他参数不变)，使两齿轮的大小

不同，由此构成的齿轮泵可以获得两种输出排量；再有变转速等[2a1241125]。

5、 降低齿轮泵流量脉动的研究[26-”。由于齿轮泵的流量脉动较大，在一些要

求较高的液压系统中，很少采用齿轮泵。关于降低齿轮泵流量脉动的方法

主要有：(1)级联齿轮泵的研究；通过两级或三级并联直齿轮泵同时输出

流量进行叠加从而使该泵的总体输出流量脉动下降汹】。(2)非对称渐开线

齿轮泵的研究；通过设计齿廓工作侧与非工作侧的非对称渐开线实现流量

脉动降低。如日本岛津制作所研制的sP系列泵【。】I驯．(3)平衡式复合齿轮

泵；由于输油的多个齿轮相位交错，其流量脉动有所下降【31Ⅱ”。

6、 齿轮泵高压化途径的研究阴习。提高齿轮泵的工作压力是齿轮泵的一个发
展方向，而提高工作压力所带来的问题是：(1)轴承寿命大大缩短；(2)

泵泄漏加剧，容积效率下降。产生这两个问题的根本原因在于饯轮上作用

了不平衡的径向液压力，且工作压力越高，径向液压力越大。目前国内外

学者针对以上两个问题所进行的研究是： (1)对齿轮泵的径向间隙进行补

偿；(2)减小齿轮泵的径向液压力，如优化齿轮参数，缩小排液口尺寸等；

(3)提高轴承承载能力，如采用复合材料滑动轴承代替滚针轴承等。其中
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复合齿轮泵在这方面有很大的发展潜力。

7、 水介质齿轮泵基础理论研究【一】。纯水作为液压泵系统的介质与环境相
容，系统简化安全，抗燃节能，经济卫生等绿色特征，满足了人类可持续

发展的需要。丹麦的Danfoss公司是水液压泵元件供应商的典型代表。其

Nessie系列已供应市场。德国的Hanhinc Gmbh公司与英国Fenner公司也有系

列水液压泵元件投入市场。我国的哈尔滨工业大学、华中科技大学等也己

取得相当的进展。

8、 高粘度齿轮泵的研究He-“。高粘度齿轮泵是指传输各种高粘度介质的齿轮

泵，通常其制造难度大，费用高，需要解决的技术问题多。国内需要的高

粘度齿轮泵多属国外进口产品。

随着对齿轮泵研究、改进的不断深入，基于齿轮泵原理的泵体结构变种不断

出现。摆线内啮合齿轮泵是最早出现的一个类型，它以一对共轭摆线齿轮作为工

作部件，与泵体、辅助部件一起构成容积变化空间。随后又出现斜齿齿轮泵，其

工作稳定性高于直齿轮泵。近年来有人提出多齿轮泵的概念，并且试制了若干形

式，以提高工作效率。平衡式复合齿轮泵就是其中的研究热点，其优点是排量和

输出功率明显增大，流量脉动减小，径向力平衡。但其结构复杂，体积大，成本

高。针对齿轮泵存在的困油现象，有不少论文发表，提出若干种改进措施，例如：

加深扩大齿槽容纳液体压缩量，开卸荷槽减小压力，适当减小重合度，采用有明

显侧隙的传动等等。但是所有的改进并未脱离以齿轮的齿槽空间作为工作容积的

框架，困油现象只是得到缓解而未根本消除，输出脉动仍然存在只是脉动量减小

了。

除了齿轮泵之外，还出现了其他类型的泵产品。叶片泵是最早出现的变量泵，

但是叶片本身容易磨损，使得工作可靠性比较低。柱塞泵也是变量泵，它的效率

高，但是柱塞的往复式和接触磨损是其缺点。离心泵、螺杆泵的工作原理有相似

之处，流量大但是容易磨蚀，旋转叶轮的设计制造难度比较高。近年来有人提出

涡旋泵，它的工作原理与涡旋压缩机相似，输送量大，但是设计制造要求很高，

国内一直未能解决其吸、排油腔的隔离密封问题。
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1．2论文研究的目的和意义

齿轮泵作为一种典型的液压动力元件广泛应用于机床工业、农用机械、工程

机械、航空航天和船舶工业等众多工业领域。它的结构简单，主被两齿轮就构成

了其主要工作部件，较之叶片泵(叶片、转子及其他附件)及各种型式的柱塞泵

(斜盘、柱塞、缸体和回程盘等部件)在原始设计、制造工艺、以及加工手段等

方面有无可比拟的优越性。它仅由一对啮合齿轮和泵体三个部件组成，因此具有

尺寸小、重量轻、制造容易、工作可靠、价格低廉、对油液不敏感、自吸能力强、

维护方便等优点，在输送液体的各种场合都获得了应用，各类齿轮泵每年的产销

量达到数百万台套，产值数十亿元人民币。虽然叶片泵、柱塞泵等性能更好。但

由于其对油液污染敏感、生产成本高等缺点，因此齿轮泵并未因此消失反而产量

稳步增加。

齿轮泵的最大缺点是输出脉动明显、机械噪音大、排量小，因此在输出平稳

性要求很高的场合就只好让位于其他类型的输送泵。齿轮泵的工作容积由齿间构

成，依靠齿轮快速运动输送齿间的液体，因此一般排量比较小。两个齿轮的啮合

轮齿既传递运动和动力，又构成吸油腔和排油腔之问的间隔和密封。由于齿轮啮

合的重合度要求大于l，连续的两齿之间就会封闭少量液体，产生所谓“困油现

象”。被“困”的液体压缩时压强急剧增大、然后又被迅速释放，这种情况成为

排油腔输出脉动、机械嗓音的诱因。另外，两腔之间的液体压差还造成附加径向

力，对于齿轮轴的设计要求提高。为了克服普通齿轮泵自身的不足，出现一些改

进的类型，如摆线齿轮泵、行星轮系齿轮泵、多齿轮泵等。与此同时，还发展了

基于其他工作原理的液体泵，如叶片泵、柱塞泵、螺杆泵等类型，但是这些类型

或者结构复杂。因而制造困难、维护不便，或者工作原理复杂、设计难度大、制

造技术要求高。

本课题拟研究、开发一种具有齿轮泵特点的大排量液体泵。大大提高齿轮泵

的性能价格比，提升齿轮泵产品的技术水平，达到在大多数场合都能替代其他泵

种的目标。本课题属于佛山市科技专项资金项目。编号为：2005030122。

1．3论文的主要研究内容

(I) 对普通齿轮泵的结构做必要的改造，将运动、动力传递功能与工作容积

5
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变化功能基本分离。使其排量增大为原泵的2倍以上。

(2) 研究新型泵的流量特性，对困油过程进行详细分析。

(3) 建立齿轮泵的优化设计数学模型。

(4) 利用ANSYS软件的APDL语言，建立齿轮泵参数化啮合仿真模型。进

行齿轮泵弯曲强度和接触强度分析，并利用ANSYS的优化设计功能进

行优化设计。

(5) 对齿轮泵的间隙与泄漏作详细研究，建立径向间隙和轴向间隙二元流动

泄漏模型，并推导出最优间隙的计算公式。

1．4本章小结

本章阐述了齿轮泵的工作原理及其特点，在对齿轮泵的研究现状和发展趋势

进行分析的基础上提出了本文的主要研究内容。

6
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第二章大排量齿轮泵的工作原理及流量特性分析

2．1大排量齿轮泵的工作原理

该新型齿轮泵是根据齿轮泵工作轮的容积变化和工作轮的啮合传动这两项基

本要求相分离的原则提出的。齿轮泵的容积变化工作原理如图2-1所示。壳体、

两侧板以及两工作轮之间形成了A、B腔：工作轮l做顺时针旋转，为主动轮。

工作轮6逆时针旋转，为从动轮。轮l、6转动过程中，B腔容积逐渐变大，形

成局部真空，成为吸液腔，吸入液体；A腔容积逐渐变小，形成排液腔，将液体

排出。泵的容积变化主要依靠大齿实现，啮合传动由小齿和大齿共同实现。

图2-1新型齿轮泵的工作原理

1．泵体2．主动轮3小齿4．大齿5大齿齿槽6．从动轮

Fig．2-1 Work principle of new gear pump

2．2齿轮泵的流量特性分析

2．2．1平均流量

新型大排量齿轮泵的流量包括两部分：一是由大齿、槽产生的流量Q1；

二是由小齿产生的流量幺．

由大齿产生的流量

Q=【石(恁一e)丑弦 (2．1)

7
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式中 嚣一一齿宽 拧一一转速 R口一一大齿齿顶圆半径 乞一一小齿

齿顶圆半径

由小齿产生的流量

Q2=石孵-,hB． (2．2)

由

咒=mzl／2+h'。A,l (2．3)

rf=哟／2-(虻+c‘)埘 (2．4)

式中脚一一小齿模数；毛一一小齿理论齿数；

肘一一大齿模数；览一一齿顶高系数；c+一一顶隙系数

因此，该类齿轮泵的流量为：

Q=2(Q+Q2)=2xBn[mzl十虻(M一册)一c‰】【吃(M+埘)+c锄】 (2．5)

q=Q／n即为齿轮泵的排量。

2．2．2瞬时流量

液压系统工作质量的好坏与泵的瞬时流量有直接关系。如果泵的瞬时流量脉

动大，不仅会使液压缸运动的平稳性、液压马达回转的均匀性变差，而且会引起

压力脉动，进而使管道、阀门乃至整个系统振动(特别是在共振时)，并发出很

强的噪声，这对轴和轴承的强度，对管接头和密封都有破坏性影响。为此必须对

泵的瞬时流量进行分析，找出影响流量脉动的因素，作为设计时选取有关参数的

依据。

在推导瞬时流量公式以前，先介绍一下扫过面积法，如图2．2所示：任意曲

线abc绕点O转过口角后，因以№=厶^柏^，所以以嘲"=缸q。，即
缸^。=4m+‰叩
也就是说任意曲线abc绕O转过占角所扫过的不规则的面积等于该曲线端点

a、c所对应的半径oa、oc(=od)转过同样角所扫过的两扇形面积之差。

8
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图2—2任意曲线转动时扫过的面积

Fig．2—2 The area when random curve rotation swept

如图2-3所示，当主动轮在峦时间内转过嘲角时，被动轮转过锄角，它们
之间的关系可根据齿轮啮合基本定律，即节圆上线速度相等的条件来决定i

口l县=口，R (2．6)

式中 觏和tD：----：1：、被动齿轮的角速度；

丑和足一一主、被动齿轮的节圆半径。

图2-3齿轮泵工作示意图

Fig．2-3 Schematic drawing of gear pump working

9
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将上式两边乘以art，并考虑到D。dt=d觋，国：破=锄，则觑=鲁嘲。
如

对齿轮泵的工作齿的几何形状进行分析可知，瞬时流量又分成大齿啮合时的

瞬时流量及渐开线小齿啮合传动所形成的瞬时流量两种情况。由该工作轮的结构

特点可知，为使大小齿在分度圆上均匀分布，每个大齿占据的弧长应为3个小齿

齿厚，即该大齿的齿顶高、齿根高是小齿齿顶高、齿根高的3倍左右。因而，其

极限转角13为(∥=2宏，乙=6x／zt，Zg、毛为大齿、小齿理论齿数)。

大齿啮合时的瞬时流量◇∈一譬～争：
此时，主动轮包围压油腔的齿面所扫过的容积奶等于其衄线所扫过的面积

(这个面积就等于足。和霸转过嘲扫过的扇形面积之差)乘以齿宽丑，即

叫：占单一毕：in忆2。一《砌 (2．7)

同理，被动轮包围压油腔的齿面所扫过的容积为

彤=占(-篮2一挚)=詈他一砭)锄=詈阮一砭)釜嘲(2．8)
式中 兄。和咒：一一主、被动齿轮的大齿顶圆半径；

咒和如一一主、被动齿轮的啮合半径。

所以，从压油腔排出去的容积为

dV：职+彤：in№2。一《)+鲁憾一砭)№ (2．9)
Z 儿

将该式两边各除以相应的时间席，便可求得从压油腔压出液体的瞬时流量为

鲸=百dV=等【憾一《)+罢阮一匙)】 (2．10)

式中含有民和如两个自变量，可利用三角函数关系加以简化。

如图2·4所示，，为啮合点C至节点P的距离，由图可知

焉=砰一2七R+，2，墨之=碍+2克吃+，2，

所以 罢砭=墨足+2蝎+鲁，2
另外由于：

10
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砭=幔+ha,。)2=砰+2S慨。+醒。，砭=@+坎：)2=霹+2足慨：+醒：

所以 会砭=8足+2R虹：+罢睇：
式中 帆和忸：一一主被动齿轮的大齿齿顶高
将这些关系式代入上述如的表达式后，便得瞬时流量的公式

醵=争【2R％+呶：)+蜒2。+砉蜒：一0+扣2】 (2．11)

对于渐开线齿轮／=％竹(R。一一主动齿轮基圆半径)，所以上式又可写成：

如=争【2墨(魄．+虹：)+蝎+妻磁：_(1+；拇砰】 (2．12)

由上式可知，泵的瞬时流量随主动齿轮的转角研按抛物线规律变化。对于本课题

所研究的齿轮泵而言，两个齿轮具有相同的参数墨=是=尺，鸭=魄：=慨，
q=毋2=毋，砚=仍=仍％=R2=咒，将这些关系式代入(2．12)得

色=Ba，[2Rha,+慨2一霹矿】 (2．13)

又因为 碍=僻+虹)2=R2+2Rha。+蜒，所以(2．13)又可写成
厶=Be@-R2一碍矿) (2．14)

疗， d，

同理，当渐开线小齿啮合时(∥∈一等一等，∥=2lr／z,)的瞬时流量，也可按上述步

骤求得瞬时流量公式为：

Q：m=Boo(磁一，2一，f妒4) (2．15)

式中：，一一小齿节圆半径

毛一一渐开线小齿基圆半径

由于本文中大齿和小齿节圆半径和基圆半径相等，即R=r，R=rb故大齿啮合时

于渐开线小齿啮合时得瞬时流量计算公式形式上一样。
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图2—4啮合点与齿轮中心的几何关系

Fig．2—4 The geometry relates between meshing point and the gear center

2．2．3流量脉动

系统的流量脉动将引起系统的压力脉动。流量脉动过大，将使得系统的工作

平稳性降低，因此，对该泵的流量脉动进行分析是很有必要的。流量脉动可用流

量相对脉动幅值(脉动率)艿来表示，它是衡量容积式液压泵流量品质的一个重

要指标。

大排量齿轮泵的流量脉动率：

6-辈唑罢直 (2．16)
Q_一+Q^女

‘ 。

计算并比较式(2．14)、(2．15)得出绋一、如。，把它们代入式(2．16)就可得到
流量脉动率。

由如=鼢暖一R2一碍伊2)，知当伊=0时瞬时流量最大，伊=R'／z8时瞬时流
量最小。

故流量脉动率为：艿=捌=币2磊2罄2‰2 2丽2 2 眨∽
Ql一+Ql曲 (《一^J十n—A一如石7％)

、 ’

2．3齿轮泵的困油分析

齿轮泵的困油现象一直是困扰液压界的问题。由于齿轮泵运转过程中工作齿
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轮的前一对轮齿尚未脱开啮合前，后一对轮齿又进入啮合，在这段时间内，同时

啮合的就有两对轮齿，在两对轮齿之间就形成了和吸压油腔均不相通的闭死容

积，而齿轮继续旋转时，闭死容积的大小会发生变化，从而引起该区域内的液体

压力急剧变化，这种现象称为困油现象。

由于液体的可压缩性很小，当困油容积由大变小时，存在于困油容积中的液

体受挤压，压力急剧升高，大大超过齿轮泵的工作压力，同时困油容积中的液体

也从一切可泄漏的缝隙中强行挤出，使轴和轴承受到很大的冲击载荷，产生很大

的径向力，增加功率损失，并使液体发热，引起噪声和振动，降低齿轮泵的工作

平稳性和寿命。当困油容积由小变大时，形成真空，使溶于液体中的空气分离出

来，产生气泡，带来气蚀、噪声、振动、流量和压力脉动等危害。

2．3．1有侧隙啮合困油特性的研究

为了保证齿轮泵平稳地啮合运转并连续均匀的供油，齿轮啮合的重合度F必

须大于l。虽然从理论上讲，重合度等于l时齿轮泵就可以正常工作，不会出现

间断吸压油现象。但由于存在制造误差，实际工作时这种情况下的重合度往往小

于l，齿轮泵不能正常工作，会出现时而输油时而不输油的不正常现象，瞬时流

量的差值可达30％，输油率很不均匀。当重合度s>l时，在啮合过程中，要求

在前一对齿尚未脱开啮合之前，后一对轮齿即已进入啮合。困油一般发生在轮齿

啮合时的接触线间形成的封闭腔内，对齿侧无间隙的齿轮泵，不论是单齿啮合区

还是双齿啮合区，其接触线阻隔的空间内都会发生困油现象；而对于齿侧有间隙

的齿轮泵，困油发生在双齿啮合区，通常齿轮传动是有侧隙的，因此本文只讨论

有侧隙啮合困油特性。

由本文所研究泵的形状特点可知，困油可分两种不同情况讨论：第一，小齿

传动时的困油；第二，大齿、槽传动时的困油。下面将分别计算。

小齿传动时，如图2．5所示，当新的一对齿在4点开始啮合时，接触线长度

达到全齿宽，前一对齿在占点啮合尚未脱开，在它们之间形成一个困油容积

V．_K 4-K，此时困油容积最大，由于存在齿侧间隙，K和K是相通的；当齿轮按

图示方向旋转，K逐渐减小，巧逐渐增大，而整个困油容积V‘逐渐减小，当齿轮

旋转到一定时，矿-为最小；当齿轮继续旋转，巧继续减小，咒继续增大，而矿’逐
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渐增大，直到前一对齿即将在C点脱离啮合时，矿t又增加到最大。

齿轮2

’、～

扁“”潞文摊∥眵／

图2-5有侧隙齿轮泵小齿传动时的困油

Fig．2-5 The trapped oil of gear pump with back lash using small tooth transmission

2．3．2困油容积的计算

由前面分析可知，齿轮泵的理论瞬时流量为

如=砌暖一R2一霹矿) (2．18)

齿轮泵扫过的容积随主动轮转角妒的变化而变化，其变化率为：

孚：篮：B(恁一R2_碍矿) (2．19)
口口 毋

由图2．5可以看出，困油时重叠啮合区段为BC，其始末两点丑，C对节点P

的相应转角为纯和％。在重叠啮合区若令P点至其中某一啮合点X的转角为

纷(％≤毂≤％)，则距该点一个基节y点的相应转角为：竹=毂-21r／zt，毛为齿

轮1小齿理论齿数。这时处于重叠啮合BC中的前一对齿轮，其扫描容积随齿轮

1转角的变化率由式(2．19)可得：

擎：B(碍一月2碍《) (2．20)
口够r

相应的其后一对轮齿扫描容积随齿轮1转角的变化率为：

粤：曰(碍一尺2霹刃) (2·21)

于是，随齿轮1转角的变化，困油容积的变化率为：

14
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苗=鼍一dd妇VX=等粤c纷一争 仁2z，

当锻=三时，有最小困油容积，令其为％，对上式积分可得齿轮泵困油容积随齿

轮转角毂的变化规律：

矿：K+丝碍魄一乡 (2．23)

同理，当大齿、槽啮合传动时，也可按上述方法计算，不同的是，式(2．21)de，卿

的值将发生变化。竹=纷一p／毛+万／乙)，将其代入式(2．22)de得：

等=筹一dd毂VX-=孵唼+}cz蚀一三一争 c224，

对上式积分可得大齿传动时齿轮泵困油容积随齿轮转角毂的变化规律：

肚％+磷呼+≥魄茜一寺2(2．25，zt z| 2zl 2z|

如图2-5，困油时，重叠啮合开始与终了时转角分别为：

％=蜀挈，％=乞筝其中==毛或乙 (2．26)％。蜀7，％2乞—■头中=2毛骂j吒 U·zoJ

式中：岛、乞分别为齿轮的啮入重合度和啮出重合度，且g=毛+乞

由图2-5可知。当小齿啮合传动时：

毛=等=蚯挚塑专=毛 (2J2，)1

E ￡ B
‘ u名7J

口、最分别为小齿的压力角和基节。

大齿、槽啮合传动时：

毛=导=正塑等篆盘坐=11．5 0．5 萼=岛仁2s，1

只 只+ 只 最
。 ’

只为小齿基节·

于是，不难求得小齿传动时，重叠啮合开始与终了时困油容积的最大变化量分别

为：
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△％=2晖等@一手△％
当大齿啮合时。重叠啮合开始与终了时困油容积的最大变化量分别为：

△％=喇唼+三)譬一虿1／"一刍2zt 2=△％zl z| z| zz|

2．4本章小结

(2．29)

(2．30)

本章提出了大排量齿轮泵的工作原理，详细分析了新型齿轮泵的流量特性，

推导出了计算平均流量、瞬时流量、流量脉动的计算公式，并对齿轮泵的困油现

象进行了深入分析，推导出了困油容积最大变化量的计算公式。
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第三章 齿轮泵的优化设计数学模型

随着液压技术的发展，齿轮泵获得了日益广泛的应用。用户对齿轮泵的性能

和质量提出了越来越高的要求，同时市场的瞬息万变要求产品的生产周期越来越

短，传统的设计方法己难以满足齿轮泵的市场需求。齿轮是齿轮泵的心脏，齿轮

参数的设计合理与否，将直接影响齿轮泵的性能如排量、噪声和寿命等等。因此，

在设计齿轮泵时必须对齿轮的参数进行优化设计，从而提高齿轮泵的性能、缩短

产品的设计周期。本文通过对齿轮泵各项性能指标的研究分析，构建了一个多目

标优化设计数学模型，对新型齿轮泵的基本参数进行优化设计。

3．1优化设计的基本原理

优化设计是从20世纪60年代发展起来的，是将最优化理论与计算机技术结

合应用于设计领域的现代设计方法。随着计算机技术的发展，优化设计在工程设

计的各个领域得到了广泛的应用。优化设计同传统设计相比，主要特点是优化设

计能使各种设计参数自动向更优的方向进行调整，直至找到一个尽可能完善的或

最合适的设计方案。传统设计大都是凭借设计人员的经验和类比设计进行，难以

获得最合适的方案。

优化设计的数学模型是对优化设计工程问题的数学描述，其一般形式为：

min，(幻 1
sJ^(x)=o(v=1，2，⋯，p)} (3．1)

岛(．D≤00,=1，2，⋯，肼)J

优化设计的数学模型包含设计变量、目标函数和设计约束三个基本要素：

n设计变量

设计变量是指在设计过程中进行选择并最终必须确定的各项独立参数。在

选择过程中它们是变量，但这些变量一旦确定以后，设计对象也就完全确定，

因此设计变量的选择与目标函数的建立有密切的关系。假设一组n个设计变量

毛，吃，毛，⋯，毛按一定的次序排列构成一个数组，这个数组在优化设计中被看成一

个n维向量x沿n个坐标轴的分量，把它写成矩阵形式则为：

17
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X=

毛

毛
●

：

毛

=【毛，屯，⋯klr
(3．2)

21目标函数

在优化设计中，将所追求的设计目标用设计变量的函数形式表达出来就构

成目标函数。它是设计中预期要达到的目标，表示为各设计变量的函数表达式：

，(z)=厂(毛，屯，⋯，≮) (3．3)

目标函数是设计变量的标量函数，优化设计的过程就是优选设计变量使目

标函数达到最优值，或找出目标函数的最小值(或最大值)的过程。优化问题可以

有一个目标函数，也可以有多个目标函数。目标函数愈多，设计的综合效果愈好，

但问题的求解亦愈复杂。对于多目标函数，可以将它们分别独立地列出来；

彳(柳=Z(墨，屯，⋯，毛)

五(．幻=五(毛，吃，⋯，k)

工(幻=‘(毛，而，⋯，k)

(3．4)

把几个设计目标综合到一起，建立一个综合的多目标函数表达式，即：
g

／(柳=∑国，·乃∽ (3．5)
i=i

式中：∞，一一第_，项指标的加权因子，加权因子是指用多项指标来建立一个总

的目标函数时，为反映出各项指标在优化设计中所占的重要程度而选取的各项

指标的常系数。

口一一优化设计所追求的目标数目。

3)设计约束

在很多实际工程问题中设计变量的取值范围是有限制的或必须满足一定

的条件，这种对设计变量取值的限制条件，称为设计约束。约束条件可以用数学

等式或不等式来表示。

等式约束是对设计变量的严格约束，其一般形式为：

鬼(朋=o(v=l，2’⋯，p) (3．6)
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而在优化设计中不等式约束更为普遍，其一般形式为：

＆(幻so(u=1，2，⋯，埘) (3．7)

建立数学模型是优化设计中非常重要的一步，建立合理正确的数学模型对

优化的效果至关重要，本章主要针对新型齿轮泵的性能特征建立齿轮泵基本参数

优化设计的数学模型。

3．2齿轮泵基本参数的优化模型

3。2，1目标函数

齿轮泵的体积大小主要取决于齿轮的体积大小，齿轮的体积愈大，齿轮泵

的体积也相应愈大，因此可以用单位排量的齿轮体积最小作为优化的目标。齿

轮的体积可以近似计算；

V=柏磁 (3．8)

根据第二章的流量特性分析，单位排量的体积为：

P2z(z)2面i砑i毒赢獗丽 (3·9)

3．2．2设计变量

当刀具压力角口和齿宽B确定后，在一定的压力，和排量g下，单位排量的

体积与大齿模数M、小齿模数m，大齿理论齿数乙、小齿理论齿数毛、大齿齿顶

高系数虻有关·又因为毛=3乙故设计变量为：

x=【毛，毪，弓，墨r=【M，肼，弓，虻r

3．2．3约束条件

a：边界约柬
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蜀@)=埘m／m一1≤0

岛(D=m／m。,一1≤0

93(x)=毛。，弓一1≤0

94∞=zt|z}。一1so

fax)=统一／虎一l茎0

96(x)=九／吮一一1≤0
岛(功=s孟／占一1≤0

g,Cx)=占／占。一1≤0

岛(功=虻。，虻-1s0
gl。∞=虻，红-1≤0

D

其中齿宽系数九=兰
roT,1

b：强度约束

蜀】(功=％／％一1兰0
蜀2(砷=％，q口一l≤0

其中： ％一一计算齿根弯曲应力

％一一许用齿根弯曲应力

％一～小齿节圆处的计算接触应力

％一一许用接触应力
c：大小齿模数约束

因为大齿、槽是均匀分布在渐开线小齿轮上的。而渐开线小齿要承担传递转

矩的功能，所以必须保证有足够的小齿(每个区段至少2个)来传递转矩。另外，

大小齿具有相同的节圆，且毛=3zs。因此约束函数表示如下；

蜀，(功=2x4+4×1，5一毛≤0 (当齿轮齿数为偶数个时，用2个大齿结构)

gb，(x)=2)(3+6x1．5一五≤0(当齿轮齿数为奇数个时，用3个大齿结构)

gl。(力=M／m=3

d：齿项圆弧齿厚约束

因为泵的密封完全靠两个大齿实现，因而，为了防止泄漏，故必须保证足够

长的齿顶圆弧齿厚。

gl，(功=最／S+m一1≤0

e：排量约束
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蜀6(力=q=2aB[mzj+览(M一胁)一c‘册】【虻(M+m)+c．埘】

3．3本章小结

本章介绍了优化设计的基本原理，并建立了大排量齿轮泵优化设计的数学模

型。

21
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第四章ANSYS软件介绍及其优化设计功能

4．1计算机辅助分析(CAE)和有限元法(FEM)

4．1．1计算机辅助分析(CAE)简介

传统的机械设备分析与计算的方法一直沿用材料力学、理论力学和弹性力学

所提供的公式来进行。由于有较多的简化条件，因而计算精度很低。为了保证设

备的安全可靠运行，常用加大安全系数的方法，结果使结构尺寸加大，浪费材料，

有时还会造成结构性能的降低。现代产品正朝着高效、高速、高精度、高性能、

低成本等方面发展，传统的计算分析方法远远无法满足要求。20年来，伴随着

计算机技术的发展，出现了计算机辅助工程分析CAE(Computer Aided

Engineering)这一新兴学科。采用CAE技术，即使在进行复杂的工程分析时也无

须作很多简化，并且计算快、精度高。常见的工程分析包括：对质量，体积、强

度等的计算分析；对产品的运动精度，动、静态特征等的性能分析；对产品的应

力、变形等的结构分析。

4．1．2有限元法的基本思想

有限元法的基本思想是将连续的求解区域离散为一组有限个、且按一定方式

相互联结在一起的单元的组合体。由于单元能按不同的联结方式进行组合，且单

元本身又可以有不同形状，因此可以模型化几何形状复杂的求解域。通常有限元

法都遵循以下基本步骤：

物体的离散化：离散化是有限元法的基础，这就是依据结构的实际情况，选

择合适的单元形状、类型、数目、大小以及排列方式，将拟分析的物体假想地分

成有限个分区或分块的集合体。假设这些单元在处于它们边界上的若干个离散节

点处相互连接，这些节点的位移将是该问题的基本未知参数。

挑选形函数或插值函数：选择一组函数，通常是多项式，最简单的情况是位

移的线性函数。这些函数应当满足一定条件，该条件就是平衡方程，它通常是通

过变分原理得到的，就可由每个“有限单元”的节点位移唯一地确定该单元中的
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位移状态。

确定单元的性质：确定单元性质就是对单元的力学性质进行描述。确定了单

元位移后，可以很方便地利用几何方程和物理方程求得单元的应变和应力。一般

用单元的刚度矩阵来描述单元的性质，确定单元节点力与位移的关系。

组成物体的整体方程组：组成物体的整体方程组就是由己知的单元刚度矩阵

和单元等效节点载荷列阵集成表示整个物体性质的结构刚度矩阵和结构载荷列

阵，从而建立起整个结构己知量：总节点载荷；整个物体未知量一一总节点位移

的关系。

解有限元方程和辅助计算：引入强制边界条件，解方程得到节点位移。一般

整体方程组往往数目庞大，可能是几十个、几百个，以至于成千上万个。对于这

些方程组需要一定的计算数学方法解出其未知量。然后，根据实际问题进行必要

的辅助计算。

完整的有限元分析流程图如图4-I所示。



广东工业大学工学硕士学位论文

图4-I有限元分析流程图

Fig．4—1 Finite element analysis flow chart

4．1．3通用有限元分析软件

大型工程结构庞大，计算模型复杂，因而，它的分析软件一般均由前后处理

器和分析求解器两个软件集成，并在两者之间常设有功能强大的软件接口，目的

是保持这两部分的相互独立性并方便于与其它软件的连接。

前处理器的主要功能是：形成并提交求解器能识别的有限元模型数据文件，

包括数据文件的输入／输出功能、自动网格划分功能、生成几何图形功能和图形

显示及输出功能。因此，前处理器要处理如下数据文件：读写描述有限元模型的

数据库文件；生成求解器可识别的输入数据文件；读写并记录各种操作的命令：

编辑过程文件等。
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求解器的主要功能是：对有限元模型形成的整体方程组进行计算和分析，包

括带宽优化、方程组求解方法的选取、确定收敛判据等等。因此，它是有限元的

理论方法、计算方法和软件分析方法的结晶。

后处理的主要功能是：处理求解器分析后的结果，包括识别求解器生成的格

式化及非格式化结果文件：将结果写成各种常用的图形文件：还要以图形、动画、

曲线、表格和文件形式分别显示求解器分析后的结果等。

软件接口的主要功能是：读写可被其它的CAD／CAE软件识别的各种文件，实

现与其它CAD／CAE软件间的数据转换功能，使得几何建模可以由第三方CAD／CAE

软件来提供，以增强了软件本身的健壮性。

4．1．4 ANSYS软件简介

ANSYS公司由John Swanson博士创立于1970年，ANSYS有限元程序是该

公司主要产品，它是第一个通过IS09001质量认证的分析设计类软件。由于

ANSYS软件具有建模简单、快速、方便的特点，因而成为大型通用有限元程序

的代表。ANSYS软件的主要功能包括建立模型、结构分析、非线性分析、电磁

分析、计算流体力学分析、接触分析、压电分析、结构优化等。

ANSYS提供了三种创建模型的方法：实体建模方法、直接建模方法和输入在

其它计算机辅助设计系统中创建的模型。ANSYS程序还提供了完整的布尔运算，

诸如相加、相减、相交、分割、粘结和重叠。在创建复杂实体模型时，对线、面、

体的布尔运算操作能减少相当可观的建模工作量。ANSYS程序还提供了拖拉、

延伸、旋转、移动、拷贝等的功能，可以大大减少建模时间。

在其它CAD系统中建立模型可以直接输入到ANSYS中进行分析。它有如下

优点：一是可利用己有CAD模型，避免重复工作；=是可利用熟悉的工具去建模。

但是，从CAD系统中输入的模型，如果不适于网格划分则需要大量的修补工作。

在本文中因为需要建立参数化齿轮模型以进行优化设计，所以只能采用直接

建模方法。

4．1．5 ANSYS静力分析步骤

1、确定结构的分析方案(线、面、体)：桁架、壳、实体等；注意线性单元和高
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次单元的使用；对称性等简化方法的运用；

2、根据分析的类型确定单元类型、实常量等，特别是单元类型的某些选项，对

于某些分析十分重要：

3、设定材料模型；

4、采用各种方法建立模型。在进行布尔运算时特别注意运算对以后分析的影响，

尤其是在某些情况下有些网格较难生成，因此对于布尔运算要慎重考虑，为解决

该闯题应尽量采用几何体素直接建模；

5、将材料、实常量等参数赋给模型，在某些情况下可以同时指定方向点；

6、按情况划分网格：自由网格或映射网格，设置合适的网格密度等，尤其注意

网格设置；

7、在生成节点和单元后，根据实际情况定义接触单元、自由度的耦合及约束方

程等；

8、施加力和约束等；

9、求解：注意设置合适的求解选项；

10、进入后处理菜单获得计算结果等；

11、评价分析结果。

4．1．6 ANSYS参数化建模功能

ANSYS软件的主要功能包括：建立模型，结构分析、非线性分析、接触分

析、结构优化等。建模时，需要先建立结构的几何模型，给出材料参数和单元类

型，最后划分网格，形成结构的有限元模型。建立几何模型有自顶向下和自底向

上两种方法。ANSYS软件提供了160多种单元。分别对应不同的分析类型与分

析材料：提供了自适应网格划分功能，程序可自动分析网格划分所带来的误差，

根据误差自动细化网格。结构分析包括：静力学分析、模态分析、谐波分析、瞬

态分析、响应谱分析、随机振动分析等。对于液压机类产品，为达到其性能要求，

主要对其进行静力学分析。

ANSYS提供了交互式和编程两种建模及分析的方法。这两种方法各有优缺

点：利用交互式进行有限元分析，简单易用，但是使用者必须熟悉该软件；而基

于编程的参数化建模及分析，第一次建模所需的时间比较长，但其功能强大，并
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且一旦模型建立好以后，修改起来十分方便。以ANSYS的开发工具APDL编写参

数化分析文件，将分析中所用到的参数均进行参数化，以此文件为基础进行分析，

当需要新产品结构设计时，只需输入必要的、合理的参数值，即可进行自动地建

模、分析和优化设计．利用ANSYS的参数化分析功能大大缩短了设计周期。

4．2 ANSYS软件优化设计的过程与步骤

无论做任何一件工作，人们总希望在一切可能的方案中选择一个最好的方

案，这就是最优化闯题，可见优化设计就是一种寻找确定最优设计方案的技术。

它产生于上世纪60年代，是应用近代数学规划论和电子计算机相结合的产物，

能使一项设计在一定的技术和物质条件下寻求一个技术经济指标最佳的设计方

案，它使传统的设计方法产生了变更。

设计方案的任何方面都是可以优化的，如尺寸、形状、支撑位置、制造费用、

自振频率、材料特性等，实际上可以参数化的闯题都可以进行优化设计。

进行优化设计首先要把实际的设计问题用数学表达式加以描述，即转化成数

学模型，然后根据数学模型的特性，选择某种适当的优化计算方法及其程序，通

过电子计算机，求得最优解。

如何将实际的设计问题转化为数学模型，这是优化设计首先要解决的关键问

题，解决这个问题必须要考虑到哪些是设计变量，这些设计变量是否受到约束，

以及问题所追寻的结果是什么，即要确定目标函数。设计变量、约束条件和目标

函数是优化设计的三个基本要素。
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图4-2优化流程

Fig．4—2 Optimum flow

4．2．1优化设计的相关概念

在ANSYS软件中，凡是能够用参数化表示的ANSYS选项均可进行优化设计，

ANSYS提供了两种优化方法即零阶方法(zero—order method)和一阶方法(first

ordermethod)，它们可以处理绝大多数的优化问题。其中零阶方法是一个很完善

的处理方法，可以很有效地处理大多数的工程问题；一阶方法基于目标函数对设

计变量的敏感程度，因此更加适合于精确的优化分析。
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对于零阶方法和一阶方法，ANSYS程序提供了一系列的分析一评估一修正

循环过程，即对于初始设计进行分析，对分析结果就设计要求进行评估，然后修

正设计，如此循环下去，直到所有的设计要求都得到满足为止。

在ANSYS的优化设计中包括的基本定义有：设计变量、状态变量、目标函

数、合理和不合理的设计、分析文件、迭代、循环、设计序列等。

1)设计变量“Design Variables(DVs)’：为自变量，往往是长度、厚度、直

径或几何模型参数，且为一个独立参数，优化结果的取得就是通过改变设计变量

的数值来实现的。每个设计变量都有上下限即边界约束，它定义了设计变量的变

化范围。ANSYS优化设计最大允许定义60个设计变量，用户所定义设计变量的

个数就是表示优化问题的维数，并且在优化设计中，要记住设计变量必须为正值。

2)状态变量’State Variables(SVs)’：是约束设计的数值，如应力、温度、热流

率、频率、变形、吸收能、消耗时间等，它们是因变量，也是设计变量的函数。

可以有上下限，也可能只有单方面的限制，ANSYS允许用户最多可定义100个

状态变量。在^NSYS软件中，状态变量是性能约束条件，即可以用设计规范中的

设计公式或者通过物理学和力学的基本分析导出的约束函数来表示。

图4-3优化数据流向的示意图

Fig．4—3 Schematic plan of the optimized data flowing
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3)目标函数“ObjectiveFunction’：是用户将要尽量减少的数值。它必须是设

计变量的函数。即可以通过改变设计变量的数值达到改变目标函数的数值。在

ANSYS软件中。用户只能定义一个目标函数，其值必须为正。为了在优化过程

中避免出现负的目标函数值，可以将一个足够大的正值加到目标函数上。

4)合理的设计“feasible design’：一个合理的设计是指满足所有给定约束条件

的设计，如果其中某个约束条件不能满足，则设计就认为是不合理的。而最优设

计是既能够满足所有的约束条件又能得到最小的目标函数的设计。

5)设计序列“design set’：是指确定一个特定模型的参数的集合，一般来说，

设计序列是由优化变量的数值来确定的，所有的模型参数(包括不是优化变量的

参数)组成了一个设计序列。

6)分析文件“analysis file’：是一个ANSYS的命令流文件，包括一个完整的分

析过程(即前处理、求解、后处理)，它必须是一个参数化的模型，即用参数定义

模型并指出设计变量、状态变量和目标函数，并且这个文件会自动生成优化循环

文件(Jobname．LOOP)，并在优化计算中循环处理。

7)优化迭代。optimization iteration’：是产生新的设计序列的一次或多次分析

循环，一般来说，一次迭代等同于一次循环，但对于一阶方法，一次迭代等同于

多次循环。

8)循环“loop’：是指一个分析周期(也可以理解为执行一次分析文件)，最后

一次循环的输出存储在文件“Jobname．OPT”中。

优化数据库记录了当前的优化环境，包括优化变量的定义、参数、所有优化

设定和设计序列集合，它存储在文件“Jobname．OPT”中，也可以随时读入到优

化处理器里，如图4-3表示优化分析中数据流向。但分析文件必须作为一个单独

的实体存在，优化数据库不是ANSYS模型数据库的一部分。

ANSYS的优化设计可以有两种方法来实现，即批处理和GUI方式，它们的

选择可根据用户的习惯和对ANSYS操作命令的熟练程度来进行。一般来说，若对

ANSYS的命令相当熟练，则可采用命令流的方式来进行，这对于复杂的需用大

量机时的分析任务来说，它比较有效。另一方面，GUI方式有更大的灵活性，而

且可以实时看到循环过程的结果。在用GUI方式进行优化时，首要的是建立模型

的分析文件，以便于后续优化处理的进行，初期交互式的操作可以帮助用户缩小

设计空间的大小，使优化过程得到更高的效率。
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优化设计一般包括以下几个步骤：

a)生成循环所用的分析文件；

b)建立与分析文件中变量相对应的参数，这一步是标准的做法，但不是必须的

(BEGIN或OPT)；

c)进入OPT，指定分析文件(OPT)：

d)声明优化变量；

e)选择优化工具或优化方法；

f)指定优化循环控制方式；

g)进行优化分析；

h)查看设计序列结果(OPT)和后处理(POSTl／POST26)。

4．2．2优化过程具体分析步骤

L生成循环所用的分析文件

分析文件必须包括整个分析过程，而且必须满足一下条件：

(1)参数化建立几何模型(PREP7)：

(2)求解运算(SOLUTION)：

(3)提取并指定状态变量和目标函数(P0sTl／P0sT26)。

分析文件是ANSYS优化设计过程中的关键部分，ANSYS程序运用分析文件构

造循环文件，进行循环分析。在ANSYS的优化分析中，用户的主要任务是建立分

析文件，并保证分析文件的正确性和完整性。在分析文件中几何模型必须采用参

数化来建立，结果也必须用参数来提取，分析文件中的分析过程要非常简练，因

为不必要的命令在优化循环中会耗费大量的机时。

建立分析文件的方法有：

(1)用系统编辑器逐行输入：

(2)采用GUI方式操作，然后将LOG文件转换为分析文件。前者适合于ANSYS

操作命令熟悉的用户，后者则适用于一般用户，但对于后者，用户必须要对LOG

文件进行大量的修改，才能适合于优化循环。

在生成分析文件时，用户还必须要注意下面几点：

1)设计变量可以在程序的任何部分初始化，一般在PREP7中定义。
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2)在GUI方式中，有时可能会遇到直接用鼠标拾取的操作，但应当避免在定

义设计变量、状态变量和目标函数时使用鼠标操作，而要用参数化的操作来代替。

对于状态变量和目标函数的提取，要用命令“*GET”来进行，当涉及到数据的存

储、加减或其他操作时，上述任务一般在“POSTl”中完成。

3)用GUI方式生成分析文件，用户可以采用数据库命令流文件来进行。前者

是通过命令“LGWRITE(Utility Menu>File>Write DB Log File)”，将数据库内部

的命令流写到文件“Jobname．LGW”中，它包含了生成当前模型的所有命令：后

者是采用“Jobname．LOG”文件作为基础文件，用系统编辑器删除该文件中所有

不必要的命令后再生成分析文件。

Ⅱ．建立优化过程的参数

在GUI方式下，优化过程中的参数一般在ANSYS数据库中分析文件来建立，

这样做的好处是初始参数值可以作为一阶方法的起点，而且，对于各种优化过程

来说，在数据库中的参数可以在GUI下进行操作，便于定义优化变量，建立数据

库参数可以选择下列任一种方法来建立：

1)读入与分析文件相关联的数据库文件“Jobname．DB’，可以用“RESUME’

命令或类似的其他命令进行。

2)将分析文件直接读入ANSYS进行整体分析，可以用。／INPUT”命令或类

似的其他命令进行，但对于大模型，该方法会耗费大量的机时。

3)仅从存储的参数文件中读参数到ANSYS中，参数文件必须是“PARSAV’

命令或相类似的命令来定义，可以用“PARRES”命令或类似命令读入。

4)重新定义分析文件中存在的参数，可用“*SET”命令或相类似的命令来定

义，然后用命令“OPVAR”来指定优化变量。

Ⅲ．进入OPT处理器，指定分析文件

首次进入优化处理器时，ANSYS数据库中的所有参数会自动作为设计序列

1这些参数值假定是一个设计序列。在GUI方式下，用户必须指定分析文件名。

这个文件用于生成优化循环文件“lobname．LOOP’，在ANSYS优化处理器中，分

析文件名无缺省值，用户必须要指定一个分析文件名，否则将出错。并且在分析

文件中，’／PREP7”或“／OPT”命令必须出现在行的第一个非空字符处。在批处

理方式中，分析文件通常是批处理命令流的第一部分，从文件的第一行到命令

“／OPT”第一次出现时，其缺省的分析文件名是’Jobname．BAT’，因此在批处理
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方式一般不要指定分析文件名。

Ⅳ．指定优化变量

即要求用户指定哪些是设计变量、状态变量和目标函数，对于设计变量和状

态变量，用户可以指定最大和最小值，同时每一个变量都有一个公差值，这个公

差值可以由用户输入，也可以选择由程序自动选取。用户可以在任意时间简单地

通过重新定义参数来改变已经定义过的参数，也可以删除一个优化变量，即该变

量将不作为优化变量使用，但该参数还是存在的。

V．选择优化工具或优化方法

优化方法时使单个函数在控制条件下达到最小值的传统方法。有零阶方法、

一阶方法和用户自定义方法。但在使用其中任何一种方法之前，用户必须要指定

一个目标函数。

优化工具是搜索和处理设计空间的技术，在ANSYS中有单步运行、随机搜索

法、等步长搜索法、乘子搜索法、最优梯度法和用户提供的方法等优化工具，并

且在使用这些优化工具前，必须要指定设计变量。

Ⅵ．指定优化循环控制方法

每种优化方法和优化工具都有相应的循环控制参数，因此在指定好优化方法

和优化工具后，用户还要选择与其工具和方法相对应的循环控制参数。

Ⅶ．进行优化分析

在进行优化分析时，优化循环文件“Jobname．LOOP”会根据分析文件生成，

循环在满足下列情况时终止：收敛、中断、分析完成。

所有的优化变量和其他参数在每次迭代后将存储在优化数据文件’Jobname．

OPT”中，最多可以存储130组这样的序列，如果已经达到130个序列，那么其

中数据最。不好”的序列将被删除。

Ⅷ．查看设计序列结果

在优化设计完成后，用户可以列出指定序列号的参数值，或列出所有参数值

的数值；也可以用图形方式显示指定的参数随迭代次数的变化，可以看出变量是

如何随迭代过程变化的。同时用户也可以在“POSTl”或“POST26’中对分析结果

进行后处理，在缺省方式下，最后一个设计序列的结果存储在文件“Jobname．RST”

或“Jobname．RTH”中，如果在运行前将命令。0PKEEP’设置为“0N’，则最佳

设计序列的数据也将存储在数据库和结果文件中，最佳结果在文件。Jobname．
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BEST(BRTH)”中，最佳数据库在“Jobname．BDB”中。

4．3本章小结

本章介绍了有限元法的基本思想，及通用有限元分析软件ANSYS的静力分

析、参数化建模功能，并详细介绍了利用ANSYS软件进行优化设计的具体过程

和步骤。
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第五章基于ANSYS的齿轮泵参数化建模与

优化

为了实现齿轮设计的系列化和实现同类零件的标准化设计。本章拟应用

ANSYS软件参数化建模的功能，对齿轮齿形进行精确绘制，建立齿轮泵的参数化

啮合仿真模型．并利用ANSYS软件的优化设计功能，以单位体积排量最小为目标

函数，实现泵体结构的优化设计。

5．1ANSYS中齿轮的精确建模

5．1．1齿轮精确建模基础

a、渐开线齿廓的形成

齿轮齿廓的渐开线方程式是在ANSYS中建立精确的齿轮模型的基础。渐开

线是当直线BK沿半径为rb的圆周作纯滚动时，直线上任意点K的轨迹就是该圆

的渐开线。此圆为渐开线的基圆，半径屹为基圆半径，B为渐开线上点K的展角，

吼为压力角。如图5．1所示。渐开线的方程式为：

I rk 2‘7cosak (5．1)
【吼=inv口k=tan％一％

’



广东工业大学工学硕士学位论文

图5-1渐开线的形成

Fig．5—1 Forming of involute

在齿轮建模的过程中需要用到任意半径圆周上的弦齿厚公式。可以由渐开线

方程推出。图5—2所示为齿轮的一个轮齿，设墨和直线CC分别为任意半径圆周

上的弧齿厚和弦齿厚；S为分度圆上的弧齿厚；r和吒分别为分度圆和基圆半径·

I墨=‘仍

{CC--2rl sin(仍／2) (5．2)

【仍=伊一2(包一目)=S／r一2(invaj—inva)
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对于变位的齿轮，分度圆上的弧齿厚s：

S=二删+2xmtan￡z (5．3)
2

所以对于变位齿轮任意半径圆周上的弦齿厚为：

CC_2‘sin[1．删,+44，xmtancc一∽啦一inv口)I (5．4)

在ANSYS中，建立柱坐标系，利用式(5．1)、(5．2)，就能精确描述渐开线齿廓。

b、大齿齿槽曲线方程‘"】

摆线的定义：当与一圆固连的一点在另一定圆上纯滚动时，与动圆固连的那

点的运动轨迹，称为摆线。当与动圆固连的点在动圆上时是普通摆线，在动圆内

时是短幅外摆线，在动圆外时是长幅外摆线(如图5-3所示)。

根据上面摆线的定义，大齿齿槽由长幅外摆线和圆弧组成。长幅外摆线即相

当于与节圆周连的大齿齿顶角在另一节圆上纯滚动时的轨迹。下面推导长幅外摆

线的方程。

如图5-3所示，向径01M可表示为：

O,M=DlO’+DM (5．5)

图5-3长幅外摆线的形成

Fig．5·3 Forming of prolate epicycloid
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由于是纯滚动，因此有：

妙=觏

长幅外摆线的直角坐标方程式为：

Ix=0lo’sin妒一0％／sin[，r／2一(≯+矿)】

【y=o,o’cos矽一DM∞s【石／2一(≯+y)】

由(5．6)、(5．7)并代入节圆半径，可得长幅外摆线的方程为；

卜“+r)sin矿-asin[≯(1+和

【y=“十，)oos矽叫cos【加+和
式中各变量的意义见图5-3所示。

5．1．2在ANSYS中齿轮泵仿真模型的建立

(5．6)

(5．7)

(5．8)

在ANSYS中，并不能直接根据函数得到曲线。因此要得到齿轮的齿廓，必

须先把推导出的函数曲线离散为点，然后再把这些点用样条曲线连接为线。得到

一个轮齿的齿廓曲线之后，在柱坐标系下进行旋转复制即可得到其它的轮齿。然

后由线生成面就可以得到一个齿轮的平面。在本文中，因为齿轮泵齿形的特殊性，

先画出一个小齿的齿廓曲线，然后旋转复制小齿，再在小齿基础上画出大齿齿廓，

旋转复制，建立局部坐标系画出齿槽曲线，最后删除掉多余线条。由所有的线生

成一个面。这样就建立起了一个齿轮的完整模型。图5-4是建立的二个大齿形式

的齿轮泵齿轮模型，图5-5是三个齿的齿轮泵齿轮模型。模型中确定齿轮形状的

各变量均用参数表示，并赋予一个初始值。
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图5-4齿轮泵仿真模型一

Fig．5-4 Gear pump simulation model 1

图5-5齿轮泵仿真模型二

Fig．5—5 Gear pump simulation model 2
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5．2 ANSYS中齿轮泵的有限元分析

5．2．1网格划分

在ANSYS中网格可以分为自由网格和映射网格。自由网格对实体模型无特

殊要求，对于几何模型，规则的或不规则的，都可以进行网格划分，并没有特别

的准则。自由面网格可以只由四边形单元组成，也可以只由三角形组成，或由两

者混合组成。映射网格划分要求体或面具有规则的形状，而且必须遵循一定的准

则。与自由网格相比，映射网格只包含四边形或三角形单元。映射网格具有规则

形状，单元成排规则排列。为了实现自动加载，本文采用映射网格。映射网格对

模型要求较高，对于本文研究的齿轮泵，由于其特殊性，因此将齿轮划分为四部

分，然后把每部分的齿廓线相连，以实现网格划分。网格划分后的结果见图5-6、

图5．7。

图5-6齿轮映射网格划分图一

Fig．5—6 Gear mapping grid division chart 1

40
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5．2．2约束与加载

图5．7齿轮映射网格划分二

Fig．5—7 Gear mapping grid division chart 2

齿轮泵中的齿轮的主要作用是使泵输出压力油，不同于一般齿轮传动中的齿

轮的作用，即齿轮泵中的齿轮副不是单纯的传动副，它还要使密闭容积连续变化

来输送有压力的液体。因此，其轮齿相互啮合的载荷只是泵工作载荷的一部分。

如果不加修饰的直接用泵的功率来确定名义载荷，则和泵中轮齿的实际负载工况

出入较大。由于其特殊性，泵中齿轮的受力与一般齿轮传动的受力不同。下面就

泵的输入扭矩、与油压力矩、啮合力矩的关系作一下分析。

(1)泵的输入扭矩与油压力矩、啮合力矩的关系

齿轮泵在输出压力油时，齿轮上作用有油压力矩，见图5—8。

41
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图5-8泵的扭矩关系示意图

Fig，5—8 Pump torque relations schematic drawing

小齿啮合时，油压力对主动轮产生的扭矩

M=PsB(ro—R。J)丁ro+Ro,一办B(ro—Ro。)生笋=圭B卸(e一《)
同理，液压力对从动齿轮产生的扭矩为

M2=去丑肇(孑一砭)(N·m)

式中民、如一一分别为啮合点至主动齿轮和从动齿轮中心oi、D2之距离(m)

‘一一小齿齿顶圆半径

办一一进油13压力

以一一出油口压力

印一一油压差

扭矩M通过油压力作用的齿面直接传递给主动齿轮，同样，鸩传递给从动
齿轮，而从动齿轮又通过啮合点E传递给主动齿轮。因此，主动齿轮上受的总的
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扭矩为：M=M+鸩这个扭矩就是泵的输入扭矩。这里忽略了轴承、轴套等处的
摩擦扭矩。它表明泵的输入扭矩一方面用以克服作用于主动齿轮上的油压扭矩

M，另一部分用以克服作用于从动齿轮上的油压扭矩即啮合力矩尬。从一般齿
轮传动来看，对齿轮弯曲强度产生影响的只是坛。而不是泵的整个输入扭矩。
从泵输出压力油来看，对齿轮弯曲强度产生影响的除了坛以外，还有齿廓AB段

和齿廓DE段面积上的油压力。因此，如果用啮合力矩即近似取泵理论输入扭矩

的一半来计算齿轮弯曲强度，显然只考虑了啮合力矩M2对齿轮弯曲强度的影响，

而忽略了压力油压力作用齿面对齿轮弯曲强度的影响，是不合理的。

同时注意到，主动齿轮虽然承受了M，必和压力油的作用，但对轮齿来说，

在整个啮合过程中，它的两侧作用有油压力和啮合力，或者只有一侧作用有啮合

力，而从动齿轮虽只承受M和油压力的作用，但对轮齿来说在啮合点到啮合完

成过程中，油压力和啮合力始终作用在齿的同一侧。因此，从动齿轮的受力状态

较主动齿轮严重得多。同时也说明了如果只用油压力对整个齿面作用来计算齿轮

强度，很显然也是不准确的。它忽略了啮合力以及啮合传动时各有关系数对弯曲

强度的影响。实际上，在齿轮转动输出压力油的过程中，并不存在一个齿只有一

侧整个齿面作用着油压力的情况。

(2)载荷的计算

通过上面的分析知道，油压力和啮合力对齿轮弯曲强度都有影响，因此，在

计算齿轮弯曲强度时应当同时考虑这两种力对轮齿的影响。也就是说，在计算这

两种力对轮齿危险截面产生的应力时，应当将应力进行叠加，这样计算出来的齿

轮弯曲强度才比较接近齿轮受力的实际情况，比较真实、准确。

另外，在齿轮啮合过程中，啮合点是不断变化的，齿轮的啮合半径咒、冠：也

跟着变化。因此，扭矩M， 鸩以及作用于从动齿轮齿侧上的油压面积也是变
化的，计算起来麻烦。为了简便，并考虑到啮合点的位置在节点附近变化，所以，

在计算啮合力矩场时，近似取咒=足：=R(节圆半径)。而在计算齿侧上受油压

作用对齿危险截面产生的弯矩M，时，近似取齿顶到危险截面间的齿面所受油压

力的一半作为集中力作用在节圆半径上．

①啮合力

啮合力矩必及啮合力E
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鸩=丢B卸(e—R2)

弓丝rb=去《埘)BZp
啮合力在圆周上产生的切向分力，即圆周力F

E=昂0051z=—÷僻一R2)BApcostz
巩

②液压力

在轮齿表面均布的液压力为：

|=apB(r．一确

5．2．3有限元法分析齿根弯曲应力

由齿轮泵的结构特点可知，齿轮泵轮齿弯曲强度最弱的部位就是从动轮上与

大齿齿槽相邻的小齿。对其加载，求解。然后在后处理程序中提取出齿根最大应

力值与齿轮材料极限应力进行比较。下面给出了求解部分的命令流。

⋯⋯⋯⋯⋯⋯．!建模部分

ET，1，PLANE42⋯3 l选择单元

rll,b l定义实常数，b为齿宽

MP,EX，1,2．06e11 l材料弹性模量

MP,PRXY,1,0．3 l泊松比

MP,DENS，1,7．8e3 l材料密度

MSHAPE，0，2D l映射网格划分

AMESH，1,4，1 l划分网格

CSYS，1

NROTAT,ALL !节点坐标系旋转为整体柱坐标

／SOLU

LSEL⋯S，9+(zl-6)／4+2
SFL，9’(zl一6)／4+2，PRES，delta_p l在齿廓线上如压力载荷，delta_p为进出

口油压差



釜三耋董三尘譬至墼誊竺茎至鍪兰蓦墨主堡些

NSEL，S，LOC，X，ml’zl／5

D，ALL⋯⋯uY，⋯， l将齿轮轴孔周向位移固定

LOCAL，18，0，0，0，0，一(2+pi／z1+posaia2)+180／pi，0，0

CSYS．18

FK，9+4‘(zl一(zl·6)／4-1)+3，FY,一((da／2)+(da／2)一d。d／4)+cos(alfa_a)+b。delta_p／db

!在关键点施加啮合力

ALLSEL

SOLVE

FINISH

，POSTl

NSORT，S，1

‘GET，STRES，SORT,，MAX!提取最大应力值

⋯⋯⋯～l后处理

图5-9示意了齿轮泵轮齿受力后的应力云图。

图5-9齿轮泵轮齿的弯曲强度分析应力云图

Fig．5—9 Gear teeth bending strength analysis stress cloud chart of gear pump
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5．2．4齿轮泵轮齿的接触应力分析

轮齿齿面接触强度不够，齿面将产生点蚀、剥落、塑性变形等损伤。为了防

止齿面产生这些损伤，必须进行齿面的接触强度计算，限制齿面的接触应力不超

过许用值。到目前为止，确定齿面接触应力时大多是利用Hertz公式，作近似

计算，计算结果有很大差别。有限元法是分析接触问题的一种有效手段。本文是

用ANSYS分析软件的接触分析功能对齿轮泵齿轮啮合过程中齿面的接触应力

进行研究。

求解接触问题有两大困难，第一，接触区域是未知的，它依赖于载荷、材料、

边界条件和其它因素。第二，大多数接触问题需要考虑摩擦，从而会导致收敛困

难。一般接触问题分为两大类：刚体一柔体接触和柔体一柔体接触。在刚体一柔

体接触问题中，一个或多个接触面被当作刚体(也就是说，相对于之接触的变形

体来说有较高的刚度)。许多金属成型就属于这类问题。柔体一柔体接触是更普

通的类型，在这类中两个接触体都是可变形，螺接的法兰盘就是柔体一柔体接触

的例子。ANSYS支持三种接触方式：面一面接触，点一面接触，点一点接触，

不同的接触分析类型有不同的特点。

1．点一点接触分析

用点一点接触单元来解决点一点接触问题时，必须预先知道接触点的位置，

这类接触问题常常要求在两接触面之间有较小的相对滑动。如果面一面接触中的

两个接触面上的节点排列成线，两面之间的相对滑动变形可以忽略不计，并且两

个面的转动变形保持很小的情况，也可用点一点接触单元来解决面一面接触问

题。

2．面一面接触分析

可以使用面一面接触单元来模拟刚体一柔体和柔体一柔体的面一面接触。对

大多数接触问题，接触向导为建立接触对提供了简单的方法。如果模型还没有被

划分网络，接触向导不起作用。如果希望建立刚体一柔体的接触模型，那么在进

入接触向导之前，只需给可能成为柔体接触面的部分划分网络。在涉及到两个边

界的接触问题中，把一个边界作为“目标”面，而把另一个作为“接触”面。对

刚体一柔体接触，“接触”面总是柔性面；对柔体一柔体的接触，接触面和目标

面都是变形体，这两个面合起来叫做“接触对”，
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程序通过相同的实常数来识别“接触对”。

3．点一面接触分析

用点一面接触单元来模拟一个表面和一个点的接触，另外，可以通过把表面

指定为一组节点，从而用点一面接触来代表面一面的接触。ANSYS程序的点一

面接触单元允许下列非线性行为：有大变形的面一面接触分析；接触和分开；库

仑摩擦滑动；热传导。使用点一面的接触单元，不需要预先知道确切的接触位置，

接触面之间也不需要保持一致的网格，并且允许大的变形和大的相对滑动。

齿轮传动中两个齿轮都是体，即为柔体一柔体接触问题，可以用点一面接触

分析方法来分析齿轮的接触应力情况。

5．2．4．1点一面接触分析的步骤

下面列出了典型的点一面接触分析的基本步骤

1．建模并划分网格；

2．识别接触对；

3．生成接触单元；

4．设置单元关键字和实常数；

5．给定必须的边界条件；

6．定义求解选项；

7．求解；

8．查看结果。
‘

第l步：建模，划分网格

在这一步中，需要建立代表接触体几何形状的模型，设置单元类型，实常数

和材料特性，用适当的单元类型划分网格。

命令：AMESH

VMESH

GUI：Main menu>Preprocessor>Mesh>Mapped>3 Of 4 Sided

Main menu>Preprocessor>Mesh>Mapped>4 to 6 sided

第2步：识别接触对

在变形过程中，必须知道哪里可能发生接触，一是知道潜在接触面，通过接

触单元来定义它们，为了更有效地进行计算(主要指CPU时间)，可以定义比

较小的、局部的接触区域，但要保证所定义的接触区域能模拟所有必须的接触。
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由于几何形状和潜在变形的多样化，可能有多个目标面和同一个接触面相互

作用，在这种情况下，必须定义多个接触对，对每个表面，需要建立～个包含表

面节点的组元。

命令：CM

GUI．．Utility>Select>Comp／Assembly>Create Component

然后就可以使用这些表面结点，在接触面之间形成所有可能的接触元。

第3步：生成接触单元

在生成接触单元之前，首先必须定义单元类型，对点一面的接触使用

CONTAC48(2维)和CONTAC49(3维)

命令：ET

GUh Main menu>Preprocessor>Element Type>Add／Edit／Delete

然后再定义接触单元的实常数，每个不同的接触面应该有一个不同的实常数

号，即便实常数的值相同，因为使用不同的实常数号，程序能够较好的区分出是

接触物体的顶面还是底面，或者是能够在不同的接触面进行较好的区分。

命令：R

RMODIF

GUh Main menu>Preprocessor>Real Constants

接着就是在对应的接触对之间生成接触单元。

命令：GCGEN
‘

GUI：Main menu>Preprocessor>Create>Elements>At Contact

对生成点一面的接触单元的几点注意：

·一般来说，生成的接触单元数不能超过所需要的2--3倍

·进行接触分析时在接触面上建议使用无中结点的单元。

·每次在新的接触对之间生成接触单元时，最好指定一个新的实常数号。

第4步：设置单元关键字和实常数

使用点一面的接触单元时，程序使用四个单元关键字和几个实常数来控制

接触行为。

单元关键字；

CONTAC48和CONTAC49使用下面的单元关键字

KEYOPT(1)：选择正确的自由度(包含或不包括温度)

48
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KEYOPT(2)：选择罚函数的方法或罚函数+拉格朗日方法

KEYOPT(3)：选择摩擦类型；无摩擦弹性库仑摩擦或刚性库仑摩擦

KEYOPT(7)：选择接触时间步，预测控制

命令：KEYOPT

ET

GUI：Main Menu>Preprocessor>Element Type>Add／Delete

第5步：加上必要的边界条件

加载过程与其它分析过程相同，在分析期问如果两个物体分开，那么刚度矩

阵变得奇异和不可求解(在静力分析中)，如果是刚度矩阵变得奇异程序将会给

出警告信息。因此建模时，尽量使接触体处于恰好接触的位置。

第6步定义求解选项

接触问题的收敛性与问题的特殊性有关，下面给出了一些典型的，在大多的

点一面的接触分析中采用的选项。

·使用KEYOPT(7)来设置合适的时间步长。

·时间步长必须是足够小的，如果时间步长太大，接触力的光滑传递将被破

坏，因此，可以打开自动时间步长。

命令：AUTOTS，On

GUI： Main menu>Solution>Load Stop opts>Time／Frequenc>Time&

Time step／Time Substps

·设置一个合适的平衡迭代次数，一个合理的平衡迭代次数通常在25和70

之间。

命令：PRED

GUI：Main menu>Solution>Load Stop opts>Nonlinear>Predictor

·设置牛顿一拉普森选项到。FULL”，同时打开自适应下降因子。

命令：NROPT，FULL，ON

GUI：Main menu>solution>Analysis options

·在接触分析中，许多的不收敛性是由使用了太大的接触刚度(实常数KN)

造成的，在分析问题时，必须找到一个合适的接触剐度。

第7步：求解

求解过程与其它分析过程相同。ANSYS提供了5种求解器，包括：波前求
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解器、雅可比共扼梯度求解器、稀疏矩阵直接求解器、预置条件共轭梯度求解器、

不完全乔勒斯基共扼梯度求解器。在接触分析中，由于接触改变了网格拓扑结构，

所以使用稀疏矩阵直接求解器最好，它采用直接消元法对矩阵求解，是一个适应

性极广的直接求解器，尤其对那些病态矩阵，如单元形状不好的矩阵，用该求解

器能克服迭代法不能求解的困难。它一般在模型为lo～15万个自由度使用，其

稳定性好，速度较快。

第8步：查看结果

可以采用一般的后处理器POSTl或时间历程后处理器POST26来查看。

5．2．4．2齿轮泵的接触应力分析

按照上面的步骤，下面将对齿轮泵进行接触分析。

对于齿轮模型在ANSYS中的准确啮合，可通过复制整个齿轮配合使用

ATRAN命令实现(如图5．10、5．11)。命令流如下：

ASEL⋯S，1,4，1
LSLA．S

LOCAL，17,0，0，0，0，180／zl，0，0

CSYS，17

ATRAN，0，1，4，l，，，1

AGEN，l，1，4，1⋯0，，0
ATRAN，17，1，4⋯1，1
LOCAL，16，0，O，0，0，90，0，O

CSYS，16

ATKAN，0，1,4，l⋯1

CSYS，0

AGEN，2，1，4，1，d⋯，0
ATRAN，16，1,4⋯1，1
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图5．10齿轮泵啮合仿真模型一

Fig．5．10 Gear pump meshing simulation model 1

图5．1l齿轮泵啮合仿真模型二

Fig．5—1 l Gear pump meshing simulation model 2

建模完成后，定义单元类型、实常数、材料属性，进行映射网格划分。接着定义
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接触对，施加边界条件和载荷并求解。这部分的命令流如下：

ET'2，CONTAI 72

ET，3，TARtj}E169

MP,EX，1,2．06E4

MP．PRXY,1,0．3

MP，EX，2，2．06E4

MP’PRXY,2，0．3

LSEL，S，，，223

NSLL，S，1

CM，CONTACT1，NODE

LSEL⋯S，97
NSLL，S，l

CM，TARGET 1，NODE

LSEL⋯S，221
NSLL，S，l

CM，CONTACT2，NODE

LSEL，S，，，98

NSLL，S，1

CM，TARGET2，NODE

CMSEL，S，CONTACTI，NODE!两个对称的接触面

TYPE，2

ESURF

CMSEL，S，TARGETl，NODE

TYPE．3

ESURF

CMSEL，S，CONTACT2，NODE

TYPE．2

ESU盯

CMSEL，S，TARGET2，NODE
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TYPE．3

ESUluF

CSYS．1

NSEL，S，LOC，X，ml*zl／5 l给两个内圆施加约束，其中左边轮是主动的，故只约

束其径向，右边的全部约束

NROTAr．ALL

D，ALL，，，，，，UX，，，，，

D，ALL，UY’-0．2

CSYS．0

LSEL⋯S，196
LSEL，A，，，l 70

LSEL⋯A，138
LSEL⋯A，226
NSLL，S，l

D，ALL，，，，，，，ALL，，，，，

ALLSEL．ALL

ANTYPE．0

NLGEOM，l

NSUBST，20，0，0

TIME．1

SOLVE

FINISH

／POSTl l进入后处理

求解完成后，就可以利用ANSYS软件生成的结果文件进行后处理。通过POSTl

后处理器就可以处理和显示大多数感兴趣的结果数据，如等效应力、接触应力等。

图5．12为齿轮泵接触分析时的yon Mises等效应力图。图5．13为齿轮泵接触应

力图。
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图5．12 vonMises等效应力图

Fig．5-12 yon Mises equivalent Stress drawing

图5．13接触应力

Fig．5-13 Contact stress
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5．3基于ANSYS的齿轮泵优化设计

对于泵而言，由于是闭式齿轮传动，且齿轮材料选为硬齿面，如45#钢表面

淬火，所以只要对齿轮弯曲强度迸行验算，用接触强度进行校核即可。因此，只

需在程序中把弯曲强度作为约束条件进行优化。

按4．2节优化设计的步骤，可以得出这部分的命令流程序如下：

FINISH

，CLEAR

*CREATE．SCRATCH l定义宏程序

m1=2

Zl=30

ha—c1=l

SIGMA=250 ‘

／prep7

⋯⋯⋯⋯⋯⋯⋯⋯⋯⋯!建立有限元模型

*IF，ml，LE，2，THEN !模数的离散化选择

m1=2

‘ELSEIF，ml，LE，2．25，THEN

ml=2．25

+ELSEIF'ml，LE，2．5，THEN ‘

m1=2．5

‘ELSEIF，ml，LE，6．5，THEN

ml=6．5

’ELSEIF，ml，LE，6．75，THEN

ml=6．75

oELSE

ml=7

’ENDIF

’IF,zl，LE，18，T髓N
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zl=18

‘ELSEIF,zl，LE，30，THEN

zl=30

‘ELSEIF，zl，LE，42，THEN

zl=42

‘ELSEIF,zl，LE，54，THEN

z1=54

·ELSE

zl=66

’ENDIF

⋯⋯⋯⋯⋯⋯⋯⋯．!求解部分

，POSTl

NSORT，S，1

*GET，STKES，SORT，，MAX!提取最大应力

Q=(2’((da2／2)‘(da2／2)-(da／2)+(da／2)+(2‘ha—cl+c—e1)+ml’ml’zO)’pi‘b

defn=(da2／2)*(da2／2)。pi’b／Q !目标函数：单位排量的体积

FINISH

‘END

*USE，SCRATCH l执行初始分析

，OPT

OPANL．SCRATCH I指定分析文件

OPVAR，DEFN，OBJ，，，0．01 1定义目标函数

OPVAR，STRES，SV,0，SIGMA l SIGMA为许用应力

OPVAR，Q，sv,loo，，i定义状态变量

⋯⋯⋯⋯⋯⋯⋯⋯⋯⋯l定义状态变量

OPVAR，ml，dv,2，20，0．25 1定义设计变量

OPVAR，z l，dv,1 8，54，6

OPVAR，ha—cl，dr,0．5，1．5,0．05

OPTYPE．SUBP l定义零阶方法

OPLOOP，PKEEPROCESS l指定优化文件从／prep开始读入
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OPSUBP,30 1设定优化迭代次数

OPEXE !执行优化分析

OPLIST，ALL，，1 1列表显示设计序列

5．4设计实例

为了便于与现有齿轮泵进行性能比较，现取连盛液压机械有限公司生产的

CBG3200齿轮泵做对比分析。

CBG3200的性能参数与尺寸如下；

排量：200ml／r额定压力12．5Mpa最高压力16Mpa额定转速2000r／min齿

宽60模数5齿数20

本论文设计的大排量泵以同等排量、压力、转速、齿宽经ANSYS优化设计

后，得到的结果如下：

齿轮材料45#表面淬火排量204．33小齿模数2小齿理论齿数30大齿模

数6大齿理论齿数lO大齿齿顶高系数O．92小齿齿顶高系数l单位排量体积为

1 195．6ram3／ral

CBG3200泵的单位排量体积可计算得出为：285lmm3／ml，因此，新型大排

量泵比普通直齿轮泵的单位排量体积降低约58％。

根据第二章推导的计算公式可算得，两种齿轮泵的性能对比如下表所示；

表5-1性能对比

Table 5一I Performance compare

单位排量体积 脉动率 困油容积最大变

化量

CBG3200齿轮泵 285lmm3／ml 10．94％ 0．321ml

小齿传 大齿传 小齿传 大齿传

优化后的新齿轮泵 1195．6ram3／ml 动时 动时 动时 动时

7．28％ 21．98％ 0．047ml 0．228ml
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5．5本章小结

本章详细介绍了大排量齿轮泵在ANSYS软件中的精确建模，及在ANSYS

中如何实现对齿根弯曲强度和轮齿接触应力的计算校核。在ANSYS中对大排量

齿轮泵实现了参数化建模、有限元分析、优化设计。并给出了优化后的设计实例。

58
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第六章齿轮泵的间隙优化设计

为了满足工业生产和用户的需要，就必须提高齿轮泵的性能，而齿轮泵的容

积效率是决定齿轮泵性能的一个重要方面，齿轮泵的间隙决定其容积效率的大

小，对齿轮泵间隙最优化设计kl，可以使其总的功率损失最小、容积效率最高，

达到提高齿轮泵性能的目的。本章拟对大排量液压齿轮泵的间隙与泄漏作详细研

究，建立径向间隙和轴向间隙二元流动泄漏模型，并推导出最优间隙的计算公式。

6．1径向间隙

径向间隙泄漏如图6．1所示，它的泄漏速度由两部分组成，一部分是由于齿

两侧压差作用下，在齿顶间隙中引起的流动速度ul(如图6-la)，另一部分是由于

齿顶以圆周速度1，运动而引起齿顶间隙艿中液体的摩擦牵连运动u2(如图6-lb)。

图6．1c是两部分速度合成为在间隙中的总速度却，径向间隙泄漏就是由这两部分

速度引起的泄漏组成。因齿顶厚Sa>>万，齿宽b>>万，故图lc可以简化为图6．2

的平行流动模型。

由图6-2得到Navier．Stockes方程在x方向的分量方程：

鱼+甜丝+v丝+国鱼：一三至+vV2u (6．n
a 礅 印 现P瓠

‘

式中：p一一流体动压强

P一一流体密度

其中3个迁移项均为零，故：

坠0t一嚣+喀+》 (6．2)
p威 ‘勿2如”

、 7
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图6-1径向间隙泄漏速度图

Fig．6—1 Radial clearance divulging speed chart

f

图6-2径向间隙模型

Fig．6—2 Radial clearance model

若流动为恒定，沿齿宽z方向上没有变化，由式(6，2)可写为：

dp d2u--，,-

夏2∥万
式中：F一一流体动力粘度

边界条件；

Y=0,u=—口兄l

Y=J，甜=0 J

式中：田一一齿轮角速度

咒一一齿顶圆半径

积分式(6．3)得：

以=妄譬+Cly+G

(6．3)

(6．4)

(6．5)
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代入边界条件确定积分常数cl，c2后得：

越=皇上o，一回+国咒哮一1】 (6．6)
凼2／z。

’

”万。
、 7

沿齿宽积分可得流量公式：

吼《筹一爿硒 @7，

求取径向最优间隙，以总的功率损失最小为设计目标。由径向间隙引起的总功

率损失P，是径向间隙泄漏功率损失乞与粘性摩擦引起的功率损失弓之和，即：

P=暑+弓=吼印+弓 (6．8)

式中：弓=rA国Ro

彳一一两齿轮齿顶摩擦总面积，A=2bS．

r一∥考叫甚+纠 @9，弘∥石叫I右+亍I ‘6’即

由式(6．7)、(6．8)、(6．9)可得总的功率损失：

，=6I垫69+．2uSyR：] (6．1。)～ ，

令：鲨：o

得到齿轮泵齿顶最佳间隙：

如[警J2 @Ⅲ
L印J

、 ’

根据上述公式，计算5．4节的设计实例，其中液压油采用L．HL22普通液压

油。处于40℃下工作。经计算齿轮泵的最悻径向间隙为0 25mm。

6．2轴向间隙

对于轴向间隙泄漏吼，人们通常只考虑了一元的流动，即油液从高压腔和过

渡区的齿根，经轴向间隙流入与低压腔相通的轴孔的流动，对齿轮泵来说，端面

实际的流动情况应为二元缝隙流动，既存在径向方向的流动蚱，也存在圆周方向

6l
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的旋转剪切流动‰。

1)径向方向的压差流动

由图6-3可以得到微元体的力平衡方程：

prdgdz+(r+dr)rdO毋=(P+at,Xr+西)dOdz+rrdOdr (6．12)

代入f：∥宰整理后积分，可以得到沿密封带速度分布规律为：

v：一三l窆+p I(h-z) (6，13)
29L毋，j

7 、 。

P

图6-3齿轮泵轴向间隙

Fig．6·3 The axis clearance of gear pump

轴向间隙的压差泄漏为：

吼=r2一一警眵剀 @∽

将压差平行流动视为汇流，并分离变量积分可得：

吼=斋 (6．15)

设高压腔包角为岛，过渡区包角为2岛，由于过渡区的油腔中压力是递减的，
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所以取平均值为等可以得到单侧泄漏量为：

吼：墼燃 (6．16)
“12∥姒R，，足)

、

2)旋转剪切流动

由Navier—Stockes方程和流体连续方程(柱坐标)出发：

p警=以一云p+詈∥刁+云[吐考+鼍]]l
轨=嗜+薏+警-o J瞒％％ J

可以得到：

吉雾=可c82v,+可p田2rzZ (6 17)
Ⅳ毋岔。 肋。

、 ’

式中：z一一法向参数坐标

将式(6．17)对z积分，并代入边界条件z=o，z=^时，vr=0，可以得到旋转剪切流

v，=去軎z(z-h)-器+}办I驴瓦砉 亩+I百锄J
对式(6．18)积分并代入边界条件，=B，r=足时，P=0。

过渡腔流量为：

(2尾+岛)肿”h(碍一碍)
t／。=——————————————————————‘—————一”

8叩ln【母／K)

3)端面粘性摩擦引起的功率损失己

在端面间隙中取环形微元，流层间的内摩擦力为：

dT：三型竺!鲨

齿轮轴向两侧由于粘性摩擦产生的功率消耗为：

弓=呓号匕=：叫一霹枷2，^

(6．18)

可得径向流量在高压腔和

(6．19)

(6．20)

(6．21)
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弓为齿根圆到齿轮轴孔半径之间由于摩擦消耗的功率，而齿顶圆和齿根圆间消

耗的摩擦功率为彤取节圆速度为平均速度：

gw一_，A如fa．7n-秘ca2R 2毋=等暖一碍)舻2R，矗(6．22)
由式(6．21)、(6．22)可以得到轴向摩擦损失功率为：

弓=巧等 (6．23)

K，=2石[(碍一霹)+2尺(眨一R；)／3]
4)轴向最佳间隙矿

由式(6．16)和式(6．19)可得齿轮泵轴向间隙泄漏引起的功率损失为：

P．=4(q2一已)印2巧面翻肇
_』学AP一望萨肿2噼一霹) (6．24)

令：掣=o，得到轴向最佳间隙为：册

肚[罐笋卜： @25，
l 2丘△尸 I”’

6．3本章小结

本章对大排量液压齿轮泵的间隙与泄漏作了详细研究，建立了径向间隙和轴

向间隙二元流动泄漏模型，并推导出最优问隙的计算公式。
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结论与展望

本文以齿轮啮合理论为基础提出了一种新型结构的齿轮泵，对齿轮泵的工作

原理、流量特性进行了详细分析。并利用ANSYS的参数化优化设计功能，实现

了基于ANSYS有限元分析的齿轮泵参数优化。主要结论和创新如下：

对普通齿轮泵的结构做了必要的改造，将运动、动力传递功能与工

作容积变化功能基本分离。分离后，排量增大为同等体积条件下普

通直齿轮泵的2倍以上。

用“扫过面积法”对改进后的齿轮泵做了流量特性分析，困油分析，

结果表明，困油程度与普通直齿轮泵相比，困油程度明显减轻。

建立了大排量齿轮泵的优化设计模型。利用ANSYS软件实现了参

数化建模，进行了弯曲强度和接触强度分析，并最终完成了优化设

计。

对大排量液压齿轮泵的间隙与泄漏作了详细研究，建立径向间隙和

轴向间隙二元流动泄漏模型，推导出了最优间隙的计算公式。

齿轮泵的性能优化，涉及到很多研究内容，由于时间、能力、实验条件所限

制，还有很多工作有待进一步深入和完善：

(1) 大排量齿轮泵的力学模型可以建立得更精确，如齿轮泵内流场的模

拟仿真。

(2) 由于齿形的特殊性，故还得设计开发专用的刀具。

(3) 可以考虑采用微线段渐开线齿廓等特殊齿形，进一步增大排量及改

善力学性能。

)

)

)

)
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2
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